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e The information in this document is current as of June, 2008. The information is subject to change
without notice. For actual design-in, refer to the latest publications of NEC Electronics data
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products.
Not all products and/or types are available in every country. Please check with an NEC Electronics
sales representative for availability and additional information.

e No part of this document may be copied or reproduced in any form or by any means without the prior
written consent of NEC Electronics. NEC Electronics assumes no responsibility for any errors that may
appear in this document.

e NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual
property rights of third parties by or arising from the use of NEC Electronics products listed in this
document or any other liability arising from the use of such products. No license, express, implied or
otherwise, is granted under any patents, copyrights or other intellectual property rights of NEC Electronics
or others.

e Descriptions of circuits, software and other related information in this document are provided for
illustrative purposes in semiconductor product operation and application examples. The incorporation of
these circuits, software and information in the design of a customer's equipment shall be done under the
full responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by
customers or third parties arising from the use of these circuits, software and information.

e While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics
products, customers agree and acknowledge that the possibility of defects thereof cannot be eliminated
entirely. To minimize risks of damage to property or injury (including death) to persons arising from
defects in NEC Electronics products, customers must incorporate sufficient safety measures in their
design, such as redundancy, fire-containment and anti-failure features.

e NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and

"Specific".

The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-

designated "quality assurance program" for a specific application. The recommended applications of an

NEC Electronics product depend on its quality grade, as indicated below. Customers must check the

quality grade of each NEC Electronics product before using it in a particular application.

"Standard": Computers, office equipment, communications equipment, test and measurement
equipment, audio and visual equipment, home electronic appliances, machine tools,
personal electronic equipment and industrial robots.

"Special":  Transportation equipment (automobiles, trains, ships, etc.), traffic control systems,
anti-disaster systems, anti-crime systems, safety equipment and medical equipment
(not specifically designed for life support).

"Specific":  Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control
systems, life support systems and medical equipment for life support, etc.

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC
Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in applications
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to
determine NEC Electronics' willingness to support a given application.

(Note)

(1) "NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its
majority-owned subsidiaries.

(2) "NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as
defined above).

M8E 02. 11-1
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CAUTION

This is a Test- and Measurement equipment with possibility to be significantly
altered by user through hardware enhancements/modifications and/or test or
application software. Thus, with respect to Council Directive 89/336/EEC
(Directive on compliance with the EMC protection requirements), this equipment
has no autonomous function. Consequently this equipment is not marked by the
CE-symbol.

EEDT-ST-005-10

CAUTION

This equipment should be handled like a CMOS semiconductor device. The
user must take all precautions to avoid build-up of static electricity while
working with this equipment. All test and measurement tool including the
workbench must be grounded. The user/operator must be grounded using
the wrist strap. The connectors and/or device pins should not be touched
with bare hands.

EEDT-ST-004-10

For customers in the European Union only

Redemption of Waste Electrical and Electronic Equipment
(WEEE) in accordance with legal regulations applicable in the
European Union only: This equipment (including all
accessories) is not intended for household use. After use the
equipment cannot be disposed of as household waste. NEC
Electronics (Europe) GmbH offers to take back the equipment.
All you need to do is register at http://www.eu.necel.com/weee
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Regional Information

Some information contained in this document may vary from country to country. Before using any NEC
product in your application, please contact the NEC office in your country to obtain a list of authorized
representatives and distributors. They will verify:

Device availability
Ordering information
Product release schedule

Availability of related technical literature
Development environment specifications (for example, specifications for

third-party tools and components, host computers, power plugs, AC supply

voltages, and so forth)
¢ Network requirements

In addition, trademarks, registered trademarks, export restrictions, and other legal issues may also vary from

country to country.

NEC Electronics Inc. (U.S.)
Santa Clara, California

Tel: 408-588-6000
800-366-9782

Fax: 408-588-6130
800-729-9288

NEC Electronics (Europe) GmbH
Duesseldorf, Germany

Tel: 0211-65 03 0

Fax: 0211-65 03 1327

Sucursal en Espaina
Madrid, Spain

Tel: 091- 504 27 87
Fax: 091- 504 28 60

Succursale Frangaise
Vélizy-Villacoublay, France
Tel: 01-30-67 58 00

Fax: 01-30-67 58 99

Filiale Italiana
Milano, Italy

Tel: 02-66 75 41
Fax: 02-66 75 42 99

Branch The Netherlands
Eindhoven, The Netherlands
Tel: 040-244 58 45

Fax: 040-244 45 80

Branch Sweden
Taeby, Sweden
Tel: 08-63 80 820
Fax: 08-63 80 388

United Kingdom Branch
Milton Keynes, UK

Tel: 01908-691-133

Fax: 01908-670-290

NEC Electronics Hong Kong Ltd.
Hong Kong

Tel: 2886-9318

Fax: 2886-9022/9044

NEC Electronics Hong Kong Ltd.
Seoul Branch

Seoul, Korea

Tel: 02-528-0303

Fax: 02-528-4411

NEC Electronics Singapore Pte. Ltd.
Singapore

Tel: 65-6253-8311

Fax: 65-6250-3583

NEC Electronics Taiwan Ltd.
Taipei, Taiwan

Tel: 02-2719-2377

Fax: 02-2719-5951

NEC do Brasil S.A.
Electron Devices Division
Guarulhos, Brasil

Tel: 55-11-6465-6810
Fax: 55-11-6465-6829
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1. Introduction

The 78K0/Kx2-L - Save It! demonstration Kit shows the system development possibilities using a NEC low
power consumption microcontroller of the 78K0/Kx2-L microcontroller family.

A preprogrammed sample project, which is written to work with the TK-78K0/KC2L demo PC graphical user
interface, provided on the CD-ROM, shows the current consumption in the different operating modes.

Furthermore an Applilet3 for 78K0/Kx2-L, IAR Embedded Workbench for 78K and IAR visualSTATE sample
projects for the 78 K0/Kx2-L can be found on the CD-ROM.

1.1 Package contents

e TK-78K0/KC2L board
e USB cable
e CD-ROM containing the TK-78K0/KC2L GUI, Applilet3 for 78K0/Kx2-L, an evaluation copy of the
IAR Embedded Workbench for 78K with 4Kbyte code size limitation and IAR visualSTATE, as well
as device drivers, sample programs and Microsoft .net
Please verify that you have received all parts listed in the package contents list attached to the 78K0/Kx2-L -

Save It demonstration kit package. If any part is missing or seems to be damaged, please contact the dealer
from whom you received your 78K0/Kx2-L - Save It!

1.2 Features

NEC Electronics yPD78F0588 low power consumption general purpose NEC 8-bit 78 K0 MCU

e NEC Electronics yPD78F0730 MCU with on-chip USB interface

o 2 latched 7-segment LEDs

e Low current consumption modes demo application with GUI for the Host PC

o Applilet3 for 78K0/Kx2-L peripheral driver configurator

e On-Board debug function (TK-78K0 debugging)

The 78K0/Kx2-L - Save It! supports an On-Board debug function by using the IAR C-SPY debugger
without a need of additional debug hardware. It allows FLASH downloading and standard debug
functions like code execution, single stepping, breakpoints, memory manipulation etc.

e Power supply by USB interface or via external power supply (power supply connector not mounted)

o The IAR Embedded Workbench for 78K is included. This package is restricted in such that
maximum program code size is limited to 4 Kbyte.

o |AR visualSTATE demo, a package of integrated tools for developing, testing, and implementing
embedded applications based on state chart diagrams.

e Full documentation is included for the NEC 78K078F0588 microcontroller, NEC 78K0 78F0730
microcontroller, IAR Systems Embedded Workbench and IAR Systems visualSTATE.

The 78K0/Kx2-L — Save It! is not intended for code development. NEC does not allow and does not
support in any way any attempt to use 78K0/Kx2-L — Save It! in a commercial or technical product.

User’s Manual U20194EE1VOUMOO
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1.3 System requirements

HOST PC A PC supporting Windows 2000, Windows XP or Windows Vista is required
for the IAR Systems Embedded Workbench demo-version.
A Pentium processor with at least 1 GHz CPU performance, with at least
256 Mbytes of RAM, allowing you to fully utilize and take advantage of the
product features. 500 Mbytes of free disk space and an additional 10
Mbytes of free disk space on the Windows system drive.

A web browser and Adobe Acrobat Reader to be able to access all the
product documentation.
Host interface USB interface that enables communication based on USB (Ver1.1 or later)

Note: Updates of the IAR Embedded Workbench for 78K, documentation and/or utilities for
78K0-SAVEIT, if available, may be downloaded from the NEC WEB page(s) at
http://www.eu.necel.com/78K0-SAVEIT

1.4 Trademarks

IAR Embedded Workbench, visualSTATE and C-SPY are registered trademarks of IAR Systems AB.
Microsoft and Windows are registered trademarks of Microsoft Corporation. Adobe and Acrobat Reader are
registered trademarks of Adobe Systems Incorporated.

All other product names are trademarks or registered trademarks of their respective owners.

User’s Manual U20194EE1VOUMOO
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2. 78K0/Kx2-L — Save It! Components

The TK-78K0/KC2L board is equipped with USB-connector and with several connectors in order to be
connected to host computers, FLASH programmer, MiniCube?2 or any external target hardware.

SW2 SW3 SW1 JP1

g, U1 JP2 SWa Q4

SWE Universal area

Figure 1: 78K0/Kx2-L — Save It! components

2.1 Operation mode settings

To support the different operation modes of the 78K0/Kx2-L — Save It! switches and jumpers are available on
the TK-78KO0/KC2L board.

The table below shows the 3 different modes and the regarding switch / jumper setting for each mode.

SW1 DEMO Debug KOUSB

SW2 DEMO EXT KOUSB
SW3.1 — SW3.3 OFF ON OFF
SW3.4 — SW3.8 Unused Any Any

JP1 Short Short Short

JP2 1-2 and 3-4 shorted 1-3 shorted 1-3 shorted

Table 1: 78K0/Kx2-L — Save It! Switch and Jumper settings

Demonstration mode: This mode has to be selected if an application is already programmed in the
device and shall run standalone. Use this to run the pre-programmed low

power consumption demonstration.

User's Manual U20194EE1VOUMOO
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Debug / Writing mode: Use this mode if you want to establish a debug session using the IAR C-
SPY debugger or if you want to write an application to the 78F0588 micro-
controller using the WriteEZ5 flash programmer software.

PC communication mode: Set this mode if you want to establish a UART communication between the
Host PC and the 78K0/KC2-L microcontroller mounted to the demonstration
kit. The Host PC has to be connected via USB1 to the 78K0/Kx2-L Save it!
demonstration kit. After connecting the board shows up as an additional
COM port on the Host PC.

22 sw1
SW1 is a 3 position switch to set following modes.

Position Mode
Left Demo
Middle KOUSB
Right Debug

Table 2: SW1 modes

2.3 sw2
SW2 is a 3 position switch to set following modes.

Position Mode
Left Demo

Middle KOUSB
Right EXT

Table 3: SW2 modes

24 SW3
SW3 is an 8 position DIP switch with following functions

Bit Mode

Mode selection (see Table 1)

Mode selection (see Table 1)

Mode selection (see Table 1)
Connected to microcontroller port pin P70
Connected to microcontroller port pin P71
Connected to microcontroller port pin P72
Connected to microcontroller port pin P73
Connected to microcontroller port pin P74

ON[O|N|BR|WIN|—

Table 4: SW3 modes

Note: Make sure to set the regarding pull-up resistor option registers (PU7) of the microcontroller if
the Pins P70, P71, P72, P73 and P74 are used. Please refer to the device user’s manual of the
78K0/Kx2-L for detailed information about the pull-up resistor option register settings.

2.5 SW4 (Reset switch)

SW4 is connected to the external reset pin of the yPD78F0588 microcontroller. External microcontroller
reset can be triggered by pushing.

2.6 SW5 (INTP1)

SWS5 is connected to the "P30/INTP1" pin of the yPD78F0588 microcontroller. It can be used as external
interrupt source.

User’s Manual U20194EE1VOUMOO
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Note: Make sure to set up the microcontroller internal pull-up resistor option register (PU12)
correctly when using this external switch. Please refer to the device user’s manual of the
78K0/Kx2-L for detailed information about the pull-up resistor option registers settings.

2.7 SW6 (INTP4)

SW6 is connected to the "P33/TO51/TI51/INTP4" pin of the yPD78F0588 microcontroller. It can be used as
external interrupt source.

Note: Make sure to set up the microcontroller internal pull-up resistor option register (PU12)
correctly when using this external switch. Please refer to the device user’s manual of the
78KO0/Kx2-L for detailed information about the pull-up resistor option registers settings.

2.8 JP1
JP1 is a switch jumper to select the power supply.

Position Function
Short USB power supply connected (USB1)
Open Power supply via CN1 or CN2

Table 5: JP1 settings

29 JpP2
JP2 is a jumper field to establish a current consumption measurement
Jumper settings setting
1-2 and 3-4 short Demonstration mode
1-3 short Debugging/Writing and PC communication mode
any other restricted

Table 6: JP2 settings

210 Q4 (illuminance sensor)

The illuminance sensor Q4 is connected to the “P10/SCK10/ANI8/AMP1-“ pin of the uyPD78F0588
microcontroller. When lightening up the voltage increases and when making dark it decreases. So the gain

amplifier function of the microcontroller can be used to read the illuminance. For further information to set up

the registers of the microcontroller to use the gain amplifier functionality please refer to the device user’s
manual.

211 U8, U10 (7-segment LED)

U8 and U10 are two 7-segment LEDs. They can be set through the latches U9 and U11. The data channels
of the latch are connected to channel P20 to P27 and the clock pins to P00 (U8) and P01 (U10) of the of the

pPD78F0588 microcontroller.
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ug u1a P20
A — L.:r P25 P21
Tr T
- - S _
P20~P2T & g
- -
P24 P22
F

. P23 o 52?
P00

POl Figure 3: 78K0/Kx2-L — Save It! 7-segment LED port pin
Figure 2: 78K0/Kx2-L — Save It! 7-segment LEDs structure connection

In respect to the pin connection the following table shows the port values to be written to show the numbers
from O to 9 on the 7-segment LEDs.

0 0xCO 5 0x92
1 0xF9 6 0x83
2 0xA4 7 O0xF8
3 0xBO 8 0x80
4 0x99 9 0x98

Table 7: 7 segment LED port values

2.12 LED1 (power LED)

LED1 is the power LED, lights up when power is supplied via USB, CN3 (not mounted) or J1 (not mounted)
to the 78K0/Kx2-L — Save It!

2.13 Universal area

The Universal area of the 78K0/Kx2-L — Save lIt! is a free for the customer to use mounting area. It can be
found in the lower right corner of the TK-78K0/KC2L board.

2.14 Minicube2 connector

If a MiniCube?2 shall be connected to the 78K0/Kx2-L — Save It! starter kit a 16-pin connector has to be
mounted to the FP1 area shown below.

Figure 4: 78K0/Kx2-L — Save It! MiniCube2 connector
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3. 78K0/Kx2-L — Save it! Solder-short pads

On the TK-78K0/KC2L board you will find several solder-short pads. By opening or connecting these pads
the circuit design of the TK-78K0/KC2L board can be customized.

AVREF_1

DCVDD1.2 ANREF AVREF_D

LED_VDD1.2

PO0~~PD1

P20~P27

P33 P30 P10

Figure 5: 78K0/Kx2-L starter kit Solder-short pads

The solder-short pad looks like the picture below. To open, use a cutter to cut the dent part. To short, put

solder on the pad.

Solder-short pad

(Open)

Solder-short pad
(Short)

P20~P27 Short | 3527~ ~ e vse port? for mulipurpose 0.~
PO0~PO1 Short |20 == e e 00,01 for mliparaces 16
P10 short  LShort __ | Port10 is connected to lluminance Sensor. ____
Open You cap use port10 for multipurpose 1/0.
P30 Short | Gpan ™| Vou can s ports0 for muipurpose 10~~~
P33 Short | Gpan ™| Vou can s ports for muipurpose 10~~~
AVREF Open | 30 = =~ AVREF is coparsted fram AVREE, "
AVREFO Short | 20 = =~ U000 s cepaaiod from AVREE. "
AVREF1 Short | 2300 = =~ VD ks semmnmted rom AVREE. "
DCVDD1,DCVDD2 Open | 30~~~ ens J1 s separsied fom VB~~~
LEDVDDT.LEDVDD2 | short 3T~ - T e e e s

Table 8: 78K0/Kx2-L — Save it! Solder short pads
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4. 78K0/Kx2-L — Save It! system configuration

The 78K0/Kx2-L — Save It! starter kit system configuration is given in the diagram below

Figure 6: 78K0/Kx2-L- Save It! system configuration

4.1 78K0/Kx2-L — Save It!

The 78K0/Kx2-L — Save It! is a demonstration kit for the 78F0588 8-bit low power consumption
microcontroller of the NEC 78K0 family. The demonstration board is connected to the host system via an
USB interface cable. The host system may be used for On-Chip debugging by using the IAR C-SPY
debugger and to allow execution of application programs on 78K0/Kx2-L — Save lt! starter kit.

78K0/Kx2-L — Save It! runs the microcontroller at 10 MHz operating speed in normal operation mode.

4.2 Host computer

The USB host interface enables communication to the 78K0/Kx2-L — Save It! board. The yPD78F0730 NEC
78K0 8-Bit microcontroller with on-chip USB interface and the NEC virtual UART driver allows application
software to access the yPD78F0588 device in the same way as it would access a standard RS232 interface.
The NEC virtual UART driver appears to the windows system as an extra Com Port, in addition to any
existing hardware Com Ports.

4.3 Power supply

The TK-78K0/KC2L board can be powered by the USB interface. Optional the power supply can be applied
via a JACK connector, which has to be mounted to CN3, or a connector plug mounted to J1.

Note: When connecting a power supply to CN3 or J1 make sure to open (disconnect) JP1!
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5. 78K0/Kx2-L — Save It! installation and operation

5.1 Getting started

The 78K0/Kx2-L — Save It! is delivered with two PC based user programs. The TK-78KOKC2L demonstration
program is designed to measure the current consumption, the CPU frequency and the actual illuminance
(measured by an illuminance sensor on the TK-78K0/KC2L board). The Applilet3 for 78K0/Kx2-L is an easy
to use GUI based program to configure available device peripherals driver which are automatically converted
into an IAR Embedded workbench or NEC PM+ project.

5.2 CD-ROM contents

NEL 78K0/Kx2-L - Save It! CD-ROM ROOT

1 Acrobat - Acrobat Reader for 32 Bit Windows OS

1 Applilet - Applilet3 for 78K0/Kx2-L

1 Doc - Documentation

1 dotnet - Microsoft .NET package

1 Driver - TK-78K0/KC2L USB driver files

_11AR Systems - IAR Embedded Workbench for 78K

- IAR visualSTATE

4 sample projects - Example projects for the 78K0/Kx2-L -
Save It! Starter Kit

1 TK-78K0 KC2L Demo - TK-78KORKESL current consumption

- - demonstration program

1 WriteEZ5 - Flash Programmer WriteEZ5 incl. PRM file

for yPD78F0588

Figure 7: 78K0/Kx2-L — Save It! CD-ROM contents
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6. Hardware installation

After unpacking the 78K0/Kx2-L — Save It! demonstration kit, connect the board via connector USB1 to your
host computer using the provided USB interface cable. When TK-78K0/KC2L board is connected, the USB
driver needs to be installed on the host machine. Please refer to the following USB Driver Installation.
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7. Software installation

The 78K0/Kx2-L — Save It! package comes with the following software packages:
e TK-78K0/KC2L demonstration program

¢ |AR Systems Embedded Workbench for 78K 4Kbyte code size limited, including C compiler,
assembler, linker, librarian and IAR C-SPY debugger / simulator

e |AR Systems visualSTATE 20 states limited demo program
o Applilet3 for 78K0/Kx2-L
o WriteEZ5 flash programmer software including PRM file for yPD78F0588

e Adobe Acrobat Reader 9.3

Demonstration Kit 78K0/Kx2-L — Save it!

NEC Software tools

NEC Sample projects

E Adobe Header 9.3

NEC Documentation

il Exit

Empowered by Innovation N E‘

Figure 8: 78K0/Kx2-L — Save It! CD-ROM autorun.exe

7.1 TK-78KOKC2L demonstration program installation

Before the TK-78KOKC2L demonstration program can be installed on the host PC it is mandatory that

the .NET Framework is installed on the host PC. For further information about installing .NET Framework
please refer to the TK-78K0_DEMO_GUI_e.pdf available on the CD delivered with the 78K0/Kx2-L — Save It!
package in the “\Doc” folder.

To install the TK-78K0/KC2L demonstration program press the Software tools button from the Autorun of the
CD-ROM provided within the 78K0/Kx2-L — Save It! package and select the regarding entry from list. The
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setup dialogues will guide you through the installation process. The installation can also be started by
executing the “TK-78K0_KC2L Demo.msi” in the directory “\TK-78K0_KC2L Demo” of the CDROM.

7.2 1AR Systems Embedded Workbench for 78K installation

To install the IAR Systems Embedded Workbench for 78K including C-SPY debugger / simulator press the

Software tools button from the Autorun of the CD-ROM provided within the 78K0/Kx2-L — Save It! package

and select the regarding entry from list. The installation can also be started by executing the Autorun.exe
program in the directory “\IAR Systems\” of the CDROM.

When running the autorun.exe the following screen appears.

* H&*ZE [Japanese]

Welcome to IAR Systems
IAR Embedded Workbench® 4K Kickstart for NEC 78K

QuickStart installation information

Inztall IAR Embedded 1'.lnlrunrkhfzn-::he‘

@ o5 @

Install visualSTATE®

Ed
-+
[~

Release notes

Yiew the product documentation

L

2% Y L

Inztall Adobe Acrobat Reader

L~

E xplore the CD

OIAR
SYSTEMS

WAk I3 Com

]

Figure 9: IAR Systems Installation screen

Note: Before installing the IAR Embedded Workbench for 78K 4KB code size limited version a
license number and key has to be requested from IAR Systems. Therefore please follow the

IAR online registration. The license number and key shall be provided within a view minutes
after the request is submitted.

To install the IAR Embedded Workbench for 78K just press the regarding button “Install IAR Embedded
Workbench®. The setup dialogues will guide you through the installation process.
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7.3 IAR Systems visualSTATE Installation

To install the IAR Systems visualSTATE press the Software tools button from the Autorun of the CDROM
provided within the 78K0/Kx2-L — Save It! package. The installation can also be started by executing the
Autorun.exe program in the directory “\IAR Systems\” of the CDROM. The IAR Systems Installation
screen will a%pear and the installation of IAR visualSTATE can be started by pressing the “Install
visualSTATE™ button. The setup dialogues will guide you through the installation process.

7.4 Applilet3 for 78K0/Kx2-L

To install the Applilet3 for 78K0/Kx2-L press the Software tools button from the Autorun of the CD-ROM
provided within the 78K0/Kx2-L — Save It! package and select the regarding entry from list. The setup
dialogues will guide you through the installation process. The installation can also be started by executing
the setup.exe in the directory “\Applilet\AP3-78K0KX2L-EE V110~ of the CDROM.

7.5 WriteEZ5 installation

To install the WriteEZ5 press the Software tools button from the Autorun of the CD-ROM provided within the
78K0/Kx2-L — Save It! package and select the regarding entry from list. The setup dialogues will guide you
through the installation process. The installation can also be started by executing the

WriteEZ5 V100 EE.exe in the directory “\WRITEEZ5” of the CDROM.

7.6 Sample projects

To copy the sample programs to your Host PC press the regarding button “Sample projects”. The setup
dialogues will guide you through the copying process. The installation can also be started by executing the

“78K0-SAVEIT sample projects V100.exe” in the directory “\sample projects” of the CDROM.

7.7 USB Driver Installation

In order to use the TK-78K0/KC2L board, the USB driver needs to be installed on the host machine. Install
the driver according to the following procedure:

Installation on Windows 2000 Page 22
Installation on Windows XP Page 26

7.7.1 Installation on Windows 2000

1. When the TK-78K0/KC2L is connected with the host machine, the board is recognized by
<Plug and Play>, and the wizard for finding new hardware is started. Click .
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Found New Hardware Wizard

Welcome to the Found New

S -
\‘? Hardware Wizard

Thiz wizard helps you install a device driver for a
hardware device.

Click.

To continue, click Nest.

< Back Cancel |

Figure 10: Found New Hardware Wizard (Windows 2000)

2. Following the window below is displayed. So, check that "Search for a suitable driver ..." is

selected, then click Next>|.

Found New Hardware Wizard

Install Hardware Device Dnvers M
A device diver iz a software program that enables a hardware device to work, with
an operating system.

Thiz wizard will complete the inztallation for thiz device:

Check that "Search for a @ USE Device
suitable driver ..." is selected.

[ device driver is & software program that makes a hardware device work, Windows

eeds driver files for your new device. To locate driver files and complete the
installation click Mext.

Wwhat do pou want the wizard to do?

* Search for a suitable driver for my device [recommended}

Click.
" Dizplay a list of the known drivers for this device o that | can chooze a specific
driver

< Back I Mext » I Cancel

Figure 11: Search Method (Windows 2000)

3. Check the "Specify a location" check box only, then click Next>].
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Locate Driver Files o
Where da pou want Windows to search for driver files?

Search for driver files far the follawing hardware device:

@ USB Device
Check that "Specify a
location" onIy is checked The wizard searches for suitable drivers in its driver databaze on pour computer and in
. any of the following optional search locations that you specify.
To start the zearch, click Mext. If you are searching on a floppy disk or CD-ROM drive,
inzert the floppy disk aor CD befare clicking Mext.

Optional zearch locations:

[ Floppy disk drives Click
< Back I Heut » I Cancel
Figure 12: Driver File Location (Windows 2000)
4. Locate to the folder "CDROM:\Driver”.
Locate File e d |
Lock i | ‘=3 Diriver j - EF [

[ Histary

:ﬂ Desktop

@ My Documents
@ My Computer
=4 3% Floppy ]
= Local Dizk [C:]
== Local Dizk [D:]
= Local Dizk [E]
== Local Dizk [F:]
=1 Remukable Disk [G:]
MEC 7OKO-5AVEIT (1]

=

b Metwork Places

File name: ‘ IMDB2S.¢.LL.inf j Open I
Files of type: ISetupInfDrmatiDn[*.inf] j Cancel |

Locate to “CDROM:\Driver”

Figure 13: Address Specification 1 (Windows 2000)

5. The setup information file “MQB2ALL.inf" is automatic selected, then click to proceed
within driver installation.
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Look jn: Ia Driver j L £ EE-

File name: [MaB2sALL | gpen |

Filez of twpe: ISetup Informatiar [*.inf) j LCancel

Figure 14: Address Specification 2 (Windows 2000)

6. After the location of the USB driver has been specified click @(I to proceed.

Found New Hardware Wizard x|
Insert the manufacturer's installation disk into the drive ok, |
zelected, and then click OF.

Cancel |

Click.

Click.

LCopy manufacturer's filez from:

I:\Diriver

Figure 15: Address Specification 3 (Windows 2000)

7. Click [Next>|.

Driver Files Search Results o
The wizard has finished searching for driver files far your hardware device.

The wizard found a driver for the following device:

@ LS Device

‘Windows found a driver for this device. Tao install the driver ‘Windows found, click Next.

NEC i divertsmgb2sallinf

Cancel |

Figure 16: Driver File Search (Windows 2000) Click.
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8. Click to complete the installation of the USB driver.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

5

_\> MEC Electronics Starker Kit Wirtual DART

Witdaws has finizhed installing the software for this device.

Click.
To cloze thig wizard, click Finish.
X
< Back T Bimish Cancel |
Figure 17: USB Driver Installation Completion (Windows 2000)
7.7.2 Installation on Windows XP
1. When the TK-78K0/KC2L board is connected with the host machine, the board is

recognized by Plug and Play, and the wizard for finding new hardware is started. At first the
hardware wizard will ask if windows should search on the windows update web, check "No,

not this time" and then click .

Found Hew Harndware Wizand

Welcome to the Found New
Hardware Wizard

Windows will search for current and updated software by
looking on waur computer, an the hardware installation CD, ar an
the Windows Update ‘Web site [with pour permizsion).

Fiead our privacy policy
Check that "No, not this time"
is selected.

Can"Windows connect to Windows Update to search for
software?

() Yes, this time only

CXT'eg, now and every time | connect a device

® L

| click.
Click Mext to continue.
I Ment > r[ Cancel ]
Figure 18: Found New Hardware Wizard 1 (Windows XP)
2. Check that "Install from a list or specific location (Advanced)" is selected, then click [Next>].
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Found New Hardware Wizard

This wizard helps vou install software for:

5B Device

f\-) If your hardware came with an installation CD
=22 or floppy disk. insert it now.

What do you want the wizard to do?

) Install the software automatically [Fecommended)

{(#)inztall from a list or specifiic location [Adwancedk
Check that "Install from a list or .
specific ..." is selected. Click Nest to confinue. Click.
—/
¢ Back II Mest » I [ Cancel ]
Figure 19: Found New Hardware Wizard 2 (Windows XP)
3. Check that "Search for the best driver in these locations." is selected. Select the "Include

this location in the search:" check box and then click [Browse].

<1> Check that "Search for the
best driver in these locations."
is selected.

Found Mew Hardware Wizard

Please chooze your search and installation options. o

location in the search:"

<2> Check ‘"Include this

P (5) Search for the best diver in these locations.

Uze the check boxes below ta limit ar expand the default zearch, which includes local
paths and removable media. The best driver found will be installed.

[I5earch removable media [floppy, CO-ROM... |

Inciude this location ik the search:

onIy. () Dan't search, | will chaose the driver ta install.
Chooze this option to select the device driver fram a list, “Windows dgeé nat guarantes that
the driver you chooze will be the best match for your hardware.
<3> Click.
l < Back ” Mext > l [ Cancel
Figure 20: Search Location Specification 1 (Windows XP)
4. Locate the folder "C CDROM:\Driver” and click [OK|
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Browse For Folder

Select the folder that contains drivers For your hardware.,

[= MBE 75k 0-5avELT (@) =
I Acrobat
I Applilet
# 17 Doc
I dotret

# I IAR Systems
# I3 sample programs
IC=) TE-78KO0_KCZL Demo
1 writeEZS
[F Se STICK_TWA (H:) ~

To wieww any subfolders, dlick a plus sign above,

[ oK, l [ Cancel

Figure 21: Search Location Specification 2 (Windows XP)

5. As shown below, "NEC Electronics Starter Kit Virtual UART has not passed Windows Logo
testing to verify its compatibility with Windows XP." is displayed. Click [Continue Anyway].

Hardware Installation

L ] "_\ The software you are inztalling for thiz hardware:
L
MEC Electronics Starter £it Wirtual LART

has nat pazsed Windows Logo testing to verify its compatibility
with Wwindows =P [Tell me why this testing iz important. |

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
pazsed Windows Logo testing.

Click.
Cantinue Anysiay l [ STOP Installation §
Figure 22: Windows XP Logo Testing (Windows XP)
6. After the installation of the USB driver is completed the window below is displayed. Click

to close the hardware wizard.

User’s Manual U20194EE1VOUMOO



78K0/Kx2-L — Save It!

NEC

Found New Hardware Wizand

Completing the Found New
Hardware Wizard

The wizard has finizhed inztaling the software far:

(3 MEC Electronics Starter Kit Virtual LART

Click Finizh to clage the wizard.

Click.

Figure 23: USB Driver Installation Completion (Windows XP)

7.8 Confirmation of USB Driver Installation

After installing the USB driver, check that the driver has been installed normally, according to
the procedure below. When using the Save It! board the “NEC Electronics Starter Kit Virtual

UART” should be present like in the figure below.

Please check in the Windows "Device Manager" within the Windows Properties (“Hardware”

tab), that the driver is installed normally.

L. Device Manager,

File  Action View Help

W EHE @ & =28

-2} ETC-LABOR
_.} Corputer

g Disk drives

-é Display adapters

i DVDICD-ROM drives

=) Floppy disk cantrollers

_ﬁ, Floppy disk drives

=% IDE ATAJATAPT contrallers

Zz» Keyboards

"y Mice and other pointing devices

& Moaritars

B8 Network, adapters

5 Ports (COM & LPT)
r;’i Communications Part (COML)
r;’i Communications Part (COMZ2)
& ECP Printsr Port (LPT1)
r.é’i MEC Electronics Starter Kik Wirtual IART [

ﬂ Processars

@%l SCSI and RAID contrallers

®), sound, video and game contrallers

e Storage wolumes

System devices
Universal Serial Bus controllers

¥

O o O o O R

H-{-E-E-E-E

Check that "NEC Electronics
Starter Kit Virtual UART (COM?)"
is present.

Figure 24: Windows Device Manager
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8. Flash Programmer WriteEZ5

WriteEZ5 is flash programming software to flash hex files to the related device. For installation information

refer to the chapter WriteEZ5 installation.

B WriteEZ5

File Device Yew Help

P& 4K

+¥ FlaghOpenning.... Device
Flash Open OK. Mame :
»» ParameterFile Reading.... Firmware :
Succesz Read ParameterFile.
»» LoadFile Reading....
Success read HEX file. -
Paramneter file
Hame : TEF05a3
Wersion : W1.00
Load fil=

Ready

Mame  DEMO_FIRM_KCZLHE
Date: 2003/12/18 05:28:12
Chiksurn :BFGdk

Area:  000000h-007FFFh

Connection to device
Port: COM4
Speed 125000
Range Chip
Freq : Intemal05C
ultiply : 1.00

MM

Figure 25: WriteEZ5 Startup

8.1 Device Setup

To provide all necessary information about the device to be programmed, only the corresponding flash

parameter file must be loaded. The parameter file (*.prm) for the yPD78F0588 is located on the CDROM in

the WriteEZ5 folder. Please use the menu “Device -> Setup...“ to open the following dialogue and the

button “PRM File Read” to select the parameter file.

..-sz Device Setup

Standard l Advance I

Parameter file 7BF0588.prm

Host conmection

[ Target Rezet Message

Port - Frequency
Speed rultiply rate
Operation Mode
'y Ehlp Start
" Block Erd
~ I

PRI File Read

Supply ozcillator

Ok, Cancel

Figure 26: WriteEZ5 Device Setup Dialogue

Please check that the correct host communication port is selected. The used communication port can be

seen in the Windows Device Manager.
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8.2 Using WriteEZ5

After a successful device selection the internal flash memory can be blank-checked, erased, programmed or
verified. WriteEZ5 can be controlled either by menu or by buttons

== WriteEZ5

File BEEEN Yiew Help
Blank Check
Erase
Program

Werify M arme :
Firmmwaare :

Device

Security
CheckSum

Autoprocedure(ERY) o ?BFDESIBamEtE[ file

Signature read Yerzion ; W1.00

3et Security setkings

Setup... Load file
Mame DEMO_FIRM_KCZLHE
Date: 200941218 052812
Chksum :BFEdh
Area:  000000W-007FFFh

Connection to device
Port:  COM4
Speed 125000
Fange Chip
Freq.: Intemal-05C
Fultiply - 1.00

(/18]y}

Figure 27: WriteEZ5 Device Menu

)/F;)j device setup button

1 load file button

blank check button

-

e —
\ erase button

i program button

verity button

%ﬁ Autoprocedure button

Table 9: WriteEZ5 action buttons

WriteEZ5 supports Intel-Hex and Motorola S-record file formats as input file.
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9. Demo application using the TK-78K0/KC2L demonstration program

The Low-Power-Consumption Demonstration GUI for the 78K0/Kx2-L — Save It! is a Windows software that
can be used to check the operation of the 8-bit microcontroller 78 K0O/KC2-L mounted on the included
demonstration kit board TK-78K0/KC2L made by TESSERA Technology Inc. by performing a simplified
display of the features and power of the microcontroller.

The Demo GUI allows the user to monitor the on-chip oscillator of the KC2-L, the power consumption, and
the optical sensor mounted on the TK Board, and to easily switch among the full-speed mode to standby
mode. The current in a user program can also be measured.

# TK-TBKO/MMC2L Ver.1.0

Operation mode selection Trace output

Clock: Internali4lMHz
AD: Full time

Clock: Internal/4MHz
AD: Interval

Clock: Internal/4MHz

AD: Stop Start

User setting ‘

FREQUENCY internal oscillation)

(MHz)
4013 [T
4
3
OPERATING CURRENT Y scale

(mA) [ 20mA |[ 2ma || 200pa |[[0AGEE|

B

ILLUMINANCE
Digital Value (Hex):

0231 0x03FF

TR e T R e
g i UM Ll MW i
550 [V

Figure 28: TK-78KOKC2L demonstration program

Note: Values displayed on the GUI
Reference values are displayed on the GUI. Results that do not satisfy the device
specifications might be displayed depending on the resistor for detecting current and the
resonator or measuring the frequency used on the board. Use the values only as a reference
for design and evaluation. Use calibrated measuring equipment if precise measurement is
required.
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For further information about usage and functionality of the tool please refer to the TK-78K0/KC2L
demonstration program User’s manual (TK-78K0_DEMO GUI e.pdf). The manual can be found on the
78K0/Kx2-L — Save It! CDROM in the “\Doc” folder.
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10. Applilet3 for 78 K0/Kx2-L

10.1 Overview

Applilet3 for 78K0/Kx2-L is an easy to use device driver Configurator for all 78 K0/Kx2-L devices. All available
internal device peripherals can be configured by this GUI based software tool. For further descriptions about
the Applilet3 refer to the regarding User's Manual (U19178EJ4V0UMO00 . pdf) available on the 78K0/Kx2-L —
Save It! CD-ROM in the “\Doc” folder.

Applilet3 for 7BKOKx2-L - 78K0-SAVEIT_sample_project.cgp
Fil= Peripheral Options Help

Owid ¥ @ 49

Project tree File  todule |
= o P?_'igheia' % Generate Code | /% 5 % T M0 8 @ & Bl ™ O
ystem .
: Port Clock setting | On-chip debug setting | Confirming reset source
..r IMT Power voltage [WDD] zetting
i Serial B & 27 )< WDD <55 s
' Operational Amplifier
w AD b ain spstem clock selection
@ Timer . " Internal high-speed oscillation [fIH) *" High-speed system clock [fXH]
w ‘watchdog Timer
..r" RTC Internal high-speed oscillation clock setting
¢ Clack Dutput Iv Operation Frequency 4 j [MHz]
w LYl
High-zpeed spstem clock zetting
r
&+ %1 ozcillation (£ " Esternal clock input [fFEXCLE)
Frequency |1 1] [MHz]
Stable time | 655360 (271682 | s
Subzyztem clock [[SUE] setting
Iv Operation
&+ XT1 ozcillation [F<T] " Esternal clock input [fEXCLES]
E Product Information Frequency |32.?58 [kHz]
#T1 ozcillator ozcillation mode zelection |L0w power consumption j
B Chip Information CPU and peripheral clock setting
CPU clock, [fCPL) |‘IDDDD [f=H) ﬂ [kHz]
B Generate File Mode Peripheral hardware clock (PRS) [1016<H) ] MHz)
Generate file Merge file
Output folder — H:ALAR projectsh 78K | - Intemal low-speed oscilation clock [fIL] setting
HEDO[.t pe HTML fie I Can be stopped by software [Option byte) [
Compiler 1AR
Frequency |30 [kHz]
i o
< >
Chip name
Chip name of selected chip

il Macro Setting

MCLNECTEKOKC2L  ChipiuPD7EFO0585_48

Figure 29: Applilet3 for 78K0/Kx2-L main window

10.2 Applilet3 for 78K0/Kx2-L sample application

After copying the sample project to the Host PC you will find the Applilet3 for 78K0/Kx2-L project file (78K0-
SAVEIT sample project.cgp) in the subfolder AP3+EWB of the location where you have copied the
sample projects to. To open this project start the Applilet3 for 78K0/Kx2-L and use the File > Open function.
After loading the project you will see the Applilet3 for 78K0/Kx2-L main window. The peripheral driver
configuration created with the Applilet3 for 78K0/Kx2-L is also be used for the IAR Embedded Workbench
78K0/Kx2-L — Save it! sample project.

User’s Manual U20194EE1VOUMOO
34



78K0/Kx2-L — Save It! NEC

10.2.1 Clock and On-chip debug settings

The system clock for this project is set up to use the high-speed system clock. This makes use of the
oscillator Y1 (10MHz) which is mounted to the target hardware. Furthermore the Subsystem clock is enabled
to generate a frequency of 32.768 KHz that is needed for the RTC. As this Applilet3 for 78K0/Kx2-L sample
project shall be used as basic driver initialization for the IAR Embedded Workbench sample the On-chip
debug function has to be enabled to configure the option bytes correctly.

Applilet3 for, 7BKOKx2-1. - 7BKO-SAVEIT _sample project.cgp

File Peripheral ©Options Help
OwrE v 54l
Project tree File  Module
Bmwﬁd | Generate Code | & s #¢ T 0 G @D & Bl M O
ystem : :
: Port Clock setting | On-chip debug setting | Confirming reset source e
.{-' IMT Or-chip debug operation zetting
' Serial . - " Unused * sed
' Operational Amplifier
w AD Internal high-zpeed ozcillation operation setting [after execution of the STOP instruction)
@ Timer . * Stop " Continue
w ‘“watchdog Timer
& RTC Pin selection
. E\'ffk Hutput @ TOOLDO, TOOLCO ¢ TOOLDT, TOOLCT
L
Securty [D zetting
z z ¥ Use Security ID
B) Flsllimeioy Securty 1D OsFFFFFFFFFFFFFFFFFFFF
Default nam ves
File name | CG_main.c Securty 1D authentication failure seting
+ Do not erase flash memary data
" Eraze flash memary data
Default name b
Drefault operation < *
MCLEMECTSKOKCZL  Chip:uPD7SFO0SE5_45

Figure 30: Applilet3 for 78K0/Kx2-L On-chip debug window

10.2.2 Timer setting

The Count mode of the IAR Embedded Workbench sample project uses an interval timer interrupt to count
up. Therefore the timer TMOO has to be configured in the Applilet3 for 78K0/Kx2-L as shown below with an
Interval value of 3.3024ms.

Applilet3 for 7BKOKx2-L - 7BK0-SAVEIT_sample_project.cgp®
File Peripheral Options Help

Owk $58® 0

Project tree File  Module
=B Peiphera Al | < generate cote | % s @ F M D B E W
L System 2
*_ Part TMO0 | THED | TR | TMHO| TrH1
@ INT Setting
w Seridl
' Operational Amplifi
w A0 2 " Unused
< — b3 (* |rterval timer
i H
E Macro Informabon Sz Uil 0
" Ewternal event counter ()
" Oreeshot pulss output ()
" PPG output ()
" Pulse width measurement ()
" Free-unning timer

Macro name
Macro name of selected macro

) Macro Setting[ Filz Set 4 p

MCUMNECTSKOKCZL  ChipiuPD7EF0S85_48

Figure 31: Applilet3 for 78K0/Kx2-L Timer Function select
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Applilet3 for, 7BKOKx2-L - 7BKO-SAVEIT_sample_project.cgp®

Fil= Peripheral Options Help
Ok ¥2 50l
Project ree | File Module|
= F'Eripheral c;\] Generate Code ﬁ; b= ..,‘1'_" A ":.Ir.. '.:() tQ
s Swstem 2
*_ Port MlTMSU THS1 || TMHO || THH1 ’
@ INT Functions| Setting |
' Serial .
. ” Count clock selection
' Operational Amplifier P p
" 44D * |nternal clock External clock (T1000] O
& Timer ) Internal clock selection
= Watchdog Tirer bt ¢ fPRS " 1PRS/2°2 & fPRS/2°8
& RTC
' Clock Output B
w LY g . -
Interval walue setting
B Macro Information Interval value |3.3024 |ms j [&ctual walue: 3.3024)
Interrupt zetting
IV Generate an interrupt each interval time [INTTHO00)
Fricrity Low -
™
Macroname < >
Macro name of selected macro
j Macro Setting l File Setting 4
MCLMECTEKOKCEL  ChipiuPD7SFOSEE_45

Figure 32: Applilet3 for 78K0/Kx2-L Timer TMOO settings

10.2.3 RTC setting

The Real-time counter has also to be configured as the Blink and the Spinning mode make use of it in the
sample project. The blink modes uses the INTERTC interrupt with an interrupt time of 0.5 seconds.

pplilet3 for 7BKOKx2-L - 7BKO-SAVEIT sample project.cgp
File FPeripheral Options  Help

Dk w5 ®H o a

Project tres | File  Module ‘
= F't_a_npshe{al S Gererste Code | T W T i B @ Bl O
wetem
:'- Pt Realtime counter settin | Interval intermupt & pin output setting
& INT Realtime counter operation setting
Wi Serial " Unused * Used
w' Dperational Amplifier
w AD Real-time counter setting
'f Timer Hour-system selection |24rhour j
:;. \::E:hdng Timer [ Setrealtime counter initial value
' Clock Output Counter valug | J
WL [~ Enable output of RTCTHZ pin (1 Hz)
Alarm detection function setting
I Use alarm detection function
-
Week day I~ r r r
I r r
E MacroInformabon HourMinte | =]
Counter comection function setting
I™ Use correction function
Corection tming | J
Cormection value | J | J [ps]
INTRTLC zetting
W Used as congtant-period interupt function [[INTRTC) Onceper05e -
-
Pricrity Low -
Macro name
tacro name of selected macio

acro Setiing | F 4 »

MCUWECTEKORCZL  Chip:uPD7EF0S8E_45

Figure 33: Applilet3 for 78K0/Kx2-L RTC settings
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The spinning mode uses the INTRTCI interrupt with and period value of 31.25ms.

> Applilet3 for 7BKOKx2-L - 7BKO-SAVEIT_sample_project.cgp

Fil= Peripheral Options Help

Ok ¥E oA

Froject tree ‘

(=% Peripheral

= System

Part

INT

Serial
Operational Amplifier
A

Timer
‘Watchdog Timer
RTC

Clack Dutput
Ll

CER IR ERERES

E Macro Information

Macroname
Macro name of selected macro

File: Mndule‘
I Generate Code | 2 S @ T 0 6L @D & Fl Mt O

Realtime counter setting | Interval interrupt & pin output setting |

INTRTCI setting
[V Intereal interrupt function INTRTCI]

" Enable autput of RTCCL pin (32 kHz)

Period value |31.25 [2™10/5LE) j [ms]

Priciity |L0w j
RTCOIM/RTCCL output setting

&+ No output

" Enable output of RTCDIY pin [ =

I acro Setting 3

MCL:NECTSKOKCZL  ChipiuPD78F0S35_43

Figure 34: Applilet3 for 78K0/Kx2-L RTCI settings

10.2.4 Interrupt setting

To switch between the modes of the sample project the mounted switches SW6 and SW6 of the
TK-78K0/KC2L board are used. These switches are connected to the external interrupt pins INTP1 and

INTP4.

'-.-_-"'Appliletii for 7BKOKx2 L - 7BK0-SAVEIT_sample_project.cgp

File Peripheral Options Help
Owid &EodH
Froject tiee ‘ File Module|
S Peipheral 5| Generate Code | % £ ¢ T L GL 6D &8 T % O
W System ey
@ Pot i Eutemnal [nterupt ‘ Key Interrupt s’
@& INT INTPO setting
= Serial B [~ INTPO Valid edge ety
w (perational Amplifier
o AD IMTP1 setting
@ Timer ¥ INTF1 Yalid edge m Pricrity Low -
m Wwatchdog Timer .
*'- BTC IMTF2 zetting
' Clock Output [ INTFZ2 alid edge Friority
w LY INTP3 setting
[~ INTP3 Valid edge Fricrity
IMTP4 zetting
= v INTP4 Walid edae Faling - Fricrity Lo -
E Macro Information
IMTPE zetting ]
[~ INTPE Walid edge Priarity
IMTPE zetting
[~ INTPE alid edge Priarity
IMTF? zetting
[~ INTF? alid edge Fricrity
Macroname IMTPE zetting
acra name of selected macra [ INTPS Valid edge Fricrity 3
tacra Setting » ‘
MCOLMNECTEKOKCZL  ChipiuPD78F0588_48

Figure 35: Applilet3 for 78K0/Kx2-L External Interrupt settings
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10.2.5 Port setting

Port2 and the Port0 pins 0 and 1 are used to control the two 7-segment LEDs of the TK-78K0/KC2L and
therefore have to be configured as input pins. The pins 0-4 of Port 7 are used as input pins connected to
SW3 (4-8). And select which segments of the two 7-segment LEDs are blinking in the Blink mode.
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11. IAR Embedded Workbench 78K0/Kx2-L — Save It! sample project

The IAR Embedded Workbench IDE is a very powerful Integrated Development Environment that allows you
to develop and manage a complete embedded application project.

The described sample project 78K0-SAVEIT sample project.eww is a part of the Sample programs
and can be found on after installation in the regarding subfolder “\AP3+EWB\applilet3 src” of the
installation.

To run/debug the project with the IAR C-SPY debugger it is necessary to follow the steps described below in
this chapter.

For further information about the IAR Embedded Workbench ant the included functionalities please refer to
the regarding User’'s manuals available on the — Save /! CR-ROM in the “\IAR Systems\doc” folder.

11.1 Hardware setup
To run the program it is necessary to set up the TK-78KO0/KC2L board in the following way.

Switch / Jumper Mode position
SW1 Debug
SW2 EXT
SW3.1 — SW3.3 ON
SW3.4 — SW3.8 Any
JP1 Short
JP2 1-3 shorted

Table 10: IAR EWB 78K0/Kx2-L — Save It! sample project hardware setup

11.2 Loading the 78K0/Kx2-L Save It! sample project

After starting the IAR Embedded Workbench for 78K the Startup window pops up. In this window you are
able to choose the Open existing workspace button.

P x|

Create new project in current workspace

Add existing project to current workspace

El B B

Open existing workspace

(i)
(i

Example applications

Recent workspaces:

Open

[ Do not show this window at startup

Cancel

Figure 36: IAR Embedded Workbench Startup window
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Then locate the sample project on the CD and open the SAMPLE-TK-78K0KC2L.eww workspace file.
Afterwards the IDE should look similar like below.

% IAR Embedded Workbench IDE

File Edit Yiew Project Tools Window Help
CeEda & | =] 2 E P P MR A Ay
x r X
|DEbU9 hd g 67 ##  PReturns: "
Files fu | B ©oBg None
69 EE]
B [ 78K0-SAVEIT _sample_pro... v .
CG_inte . Y
N 72 void mainivoid)
. 73 4
CG_F'D“-C - ' 74 A% Start user code. Do not edit comment generated here #/
[ CG_port_userc N g 75 THCOO |= Ox0OC; 4% anable Timer counter operatio
* E 76 RTCE = 111; A% enable RIC counter operation
B LT g_start = 0;
X N LB while (1)
CG_systermn_userc « | ® i
CG_systemninit.c « .80 _ enable_interrupt():
CG_timer.c . o8l g_led s =0
G_timer_userc « .
CG_userdefine.c . a3 FIE4 = lf /: INTPS mask
[:IOutput g;l RTCINE =1: A% RTCT interrupt 51.26ms mask
.86 g_count = 0;
| a7 CROOO = 0x0040; A% set timer Fregquency to initi
E g8 THIFOOO = 0; AE O IMOQ0 int F oclr
1 g9 THMEOOO = 0; A IMOO0 unmask
1 a0
E 91 while( g_start == 0 ) A* slowly & stop
: a2 i
T if [ g led s »= 40 ) =
TOKO-SAVEIT _zample_project |.F[]| | 4 | LI_‘
x
Messages b
Tatal number of errars: 0
Total number of warnings: 0
A\ Changed project file will force & full rebuild: HAYAR projects\78KI-SAVEITV7BKI-SAVEIT sample_projectappliletd_src v
< >
%Dehug Log x
|Ready Etrors 0, Warnings 1 Ln 89, Col 38 UM -
]

Figure 37: IAR Embedded Workbench Main IDE window

To verify that the right debugging device is chosen please open the project options window by clicking
Project - Options and then open the tab Debugger.

Note: Although the On-board debug interface is used, the MINICUBE C-Spy driver must be selected
instead of the standard driver TK-78K used for other starter kits. If the debug session via
MINICUBE2 and the OCD1 connectors shall be started, also the MINICUBE C-Spy driver must
be selected.

The corresponding COM port where the TK-78K0/KC2L board is connected to the host PC will be detected
automatically by the IAR C-SPY debugger.
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Options for node *78K0_SAVEIT sample_project”

Categary: Factory Settings

General Options
CIC++ Campiler

Assembler
Custam Build Setup ]Er:tra Dptinns] Images] F'Iugins]
Build Ackions )
Linker Criver
ar |MINICUBE QB-FEKOMINI, QB-7BKDS e NI, DE-HINIZ v |
IE-75 ¥ Runto
IECUBE :
MIMICLEE main
Sirnulator Setup macros
Tk-75

™ Use macro file

| B

Device dezcriptions
™ Ovemide default

B

ak. | Canhcel |

Figure 38: IAR Embedded Workbench Debugger Options

The next step is to check that the correct linker settings are set. This can be done in the “Linker” category as
shown below. Select the “Config” tab and check that the linker command file “Ink78f0588.xcl” is selected.
This file is used by the linker and contains information on where to place the different sections of code, data
and constants that may be used within the demo project:

Options for node “78K0_SAVEIT_sample_ project

Categony: Factomy Setting:

General Options
CJC++ Compiler

Assembler -
Custom Build Output | Estra Output | #idefine | Diagnostics | Lt Config lF'rc-ce ar
Build Actionis Linker carmand file
v Dveride default
Debugger [$PROJ_DIR$EE [
IE-75
IECUBE
MINICUEE
Simulator [ Overide default program entry
TE-75 & |
T

Search paths: [one per ling)
$TOOLKIT_DIR$ALIBY

Baw binary image
File: Symbal: Segment:  Align:

| 2] o

)4 | Cancel |

Figure 39: Embedded Workbench Linker Configuration
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Now after everything has been setup correctly it's time to compile and link the demonstration project. Close
the Options menu and select “Rebuild All” from the “Project” menu. If the project is compiled and linked
without errors or warnings it can now be downloaded to the 78K0/Kx2-L Save It/ board and debugged.

To start the IAR C-SPY debugger select the option “Debug” from the “Project” menu or press the ( & )
“Debugger” button.

When first starting the debugger connection, after building the project, it is necessary to set up the right
connection settings. Please take care that the following settings are chosen:

e ID code = FFFFFFFFFFFFFFFFFFFF

e Main clock = System 8.00 MHz

e Target connect = TOOLC/D

MINICUBE2 Hardware Setup for 7BK0 (7BF05BB48B) E|
D et
FFFFFFFFFFFFFFFFFFF
Cancel
b ait clock
{ i
o i Default
* System i Target connect
R I] | MHz TOOLC/D -
Manitar clock Target power off
(% Syztem & . &+ Permit
" User - l'" " Mot Permit
Fin maszk.
r [~ TARGET RESET -
I [ INTERMAL RESET
Memony map

(w0000 - 0x7FFF Internal ROM 32 Kbytes
0xFEQO - OFEFF Intemal Rak 1024 bytes

[ e
[ e

Figure 40: IAR Embedded Workbench MINICUBEZ2 settings

Now the debugger is started and the demo project is downloaded to the 78K0/Kx2-L Save Itf! board. The
progress of downloading is indicated by blue dots in the MINICUBE Emulator window. Please note that
downloading of larger executables may take some time.

After the download was completed all debug features of IAR C-SPY debugger are available, i.e. Single
Stepping, Step Over/-In/-Out, Go-Execution, Breakpoints, Register / Memory view etc.

To get more details on the debugger configuration and capabilities please refer to the “78K IAR Embedded
Workbench IDE User Guide” of the IAR installation.
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7 IAR Embedded Workbench IDE E)=)X)
Fle Edt Wiew Frojsct Debug Emulstor Tools Window Help
= U B | ob o
-x [T x
67 ++ Teturns: :‘ Expression Walue Location Type
Files fr BB - Rone - a_led s 1a kemon:0xFBO0 unsig
= L ogass start " {00 Memary:0xFBOE unsig
O ) 78K0-SAVEIT sam..  « " A (0<00) be g
Fa ) CGinte .. 0 e
CG_int_user.c ! 7zvoid wainivoid)
CG_main.c T
[0 CG_porte P74 /% Start user code. Do not edit comment gemerated here #/
[} CG_port_user.c B 75 THCOO |= 0x0C: /% enable Timer counter operation
B CG_rtce E 76 RTCE = 1U: /* enable RIC counter operation *
CG_rtc_userc P77 g_start = 0;
CG_system.c I while (1)
CG_system_user.c L i
CG_systeminite : &0 __enable_interrupt():
CG_timer.c : 28 g led 5 = 02
CG_timer_user.c poo82 n
0 C6_userdefine.c :: ;fé‘rlm( : i: jr ;Nrg‘g szk t 51,25 x
DOutput i - B IRTErIUp «25RS BaS
13 g_count = 0; & 2
a7 CROO0 = Ox0040: S* set timer frequency to initla. x
&8 THIFOOD = 02 J* D009 int Foolr T
Goto | |Memar | |E
89 TIIEODD = 02 S D000 unmask J | e J ’E
an main ~
a1 while( g_start == 0 ) S* slowly & stop 313; Eggé ggv g
9z 1 040B FeBA HOW THC
9% if (g led 3 3= 40 )
04 R 040D a100 Jitoy &
95 THMKOOO = 1 S MO0 mask et #lgadh SelL RT(
96 g_start = 1 0412 SEDEFE HOV g_:
a7 PIFl =0 /% INTPL int F clr 041% Fhal ER Ozl
98 PHMEL =0 /% INTPL unmask 0417 SEO0FE MOV A
: 99 RTCIF = 0O /% BIC int F clr 041k 4028 CHE Aj
;o loo RTCHK = O A* RIC int unmask 041C D14 EC Dxi
Dol )
LoLoz 3 041E 4101 HOY A
T 0420 716AES SETL ME(
E 104 while( g_start == 1 | /* LED brink 0423 9EQ6FE MOV g:
{108 1 = v
7BKOSAVEIT_sample_project £l 1+ ' Nl >
= Log

Mon Feb 01 11:56:22 2010: C-5FY Processor Descriptor W4.62.1.50009 for 78K0 and 78K0S

Maon Fel 01 11:56:22 2010: C-8FY MINICUBE Emulator Driver V482.1.30009 for 78K0 [Kickstar]

Mon Feb 01 11:56:44 2010: Download cornplete

Mon Feb 01 11:56:44 2010: Loaded debugee: HAAR projectsi78KI-SAVE TZKD-SAVEIT _sample_projectappliletd_src\DebughExel 78K0-SAVEIT_sample_project.d26
Mon Feb 07 11:56:45 2010: Target reset

hon Fel 01 11:56:45 2010: 78K0 MINICUBE Executorv2.10

QCD Control Code V3.00

Device chipname: uPD7BFN588_48(f058848), file version: ¥2.00

Boardinfo: 00008804, productid: 4100 wersion: A, firmware wersion: 04.06

Debug Log | Build

Ready NUM

Figure 41: IAR C-SPY debugger

L

11.3 Running the application

After downloading the project to the device the debugger window opens and, if not changed by the user, the
program runs to the first instruction of the main() function. When reaching this point the necessary clock
initialization is already executed.

This sample project makes use of different timer interrupts to control the 7-segment LEDs available on the
TK-78KO0/KC2L board. So this project gives a short overview about timer initialization and timer interrupts
usage of one timer as well as the real time clock (RTC) peripheral.

11.3.1 Count mode

When resuming execution of the program, after the break when entering the main function, the controller
starts to count up from 0 to 39 on the 7-segment LEDs. This is controlled by the timer TMOO which is
initialized as an interval timer. Furthermore every time the interrupt occurs and the value is counted up the
interval time increases. During this stage both external interrupts INTP1 and INTP4 are disabled.

11.3.2 Blink mode

After the counter reached its final value of 39 the used timer interrupt is masked and the RTC interrupt will
be unmasked and is used for the next stage. Furthermore INTP1 is unmasked to be able to leave this stage
whenever the user wants to.

The only function of this stage is to let the final counter value blink in a frequency of 2Hz controlled by the
RTC interrupt. To leave this stage SW5 has to be pressed once.
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11.3.3 Spinning mode

When entering the Spinning mode the RTC interrupt and the INTP1 will be masked again. In exchange the
RTCI Interrupt, which occurs every 31.25ms and the INTP4 are unmasked. The function of the Spinning
mode is to spin 1 active segment around the 2 x 7-segment LEDs. So every time a RTCI interrupt occurs the
active segment is stepped clockwise to the next segment on the outer ring of both 7-segment LEDs. To
leave this mode the SW6 has to be pressed to trigger an external interrupt. When leaving the spinning mode
the Count mode is entered again.
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12. IAR visualSTATE 78K0/Kx2-L — Save It! sample project

IAR visualSTATE is a Windows-based software package of integrated tools for developing, testing, and
implementing embedded applications based on state-chart diagrams. It includes a graphical design
environment, test tools, a code generator, and a documentation facility.

IAR visualSTATE has been developed in accordance with the Unified Modeling Language notation (UML).

For more information please refer to the UserGuide.pdf included to the 78K0/Kx2-L —Save It! CD-ROM in
the “\doc\visualSTATE” folder or to the visualSTATE homepage

Note: Before installing IAR visualSTATE please make sure that you have installed the IAR
Embedded Workbench for 78K delivered with the 78K0/Kx2-L Save it! demonstration kit.

Note: After installing IAR visualSTATE copy the the swtdvs.dll to the <EW>\78k\bin directory and
the vs.ewplugin file to <EW>\common\plugins directory. These files are located in the “IAR
Systems\Plugin” folder of the demonstration kit CD-ROM.

The described sample project React . vnw is a part of the Sample programs and can be found on after
installation in the regarding subfolder “\visualSTATE\vS” of the installation.

12.1 Hardware setup
To run the program it is necessary to set up the TK-78K0/KC2L board in the following way.

Switch / Jumper Mode position
SWA1 Debug
SW2 EXT
SW3.1 — SW3.3 ON
SW3.4 —SW3.8 Any
JP1 Short
JP2 1-3 shorted

Table 11: IAR VS 78K0/Kx2-L — Save It! Sample project hardware setup

12.2 Functionality of the sample project

The example implements a reaction timing measurement application that measures your reaction time a
fixed number of times and then displays the average reaction time in hundredths of a second. The
application works in the following way:

e When the application is started it displays two '-' characters on the display and waits for a press on
any of the two buttons.

e Atimer with a fairly random interval is now started and when the timer times out a '[' or 'I' symbol is
displayed on the left or right digit respectively. A new timer is also started for the measurement of
your reaction time.

e You should now as fast as possible press the left button (SW5) if the [' is shown or the right button
(SWe) if the '] is shown. The time for you to react is read from the timer and added to a running sum.

e After a button press the process is repeated until 10 trials has been performed. Your average
reaction time is now displayed and you can press a button to get back to the initial state and restart
the measurement if you want to.

The state machine is implemented with 3 input events (button presses and an expired timer) and 10 small C
functions for the interface to the hardware. There are 5 states to keep track of what is currently going on in
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the application. This is not the only plausible state machine implementation for this application. An
alternative could for example be to have separate, parallel and communicating state machines for time
measurement and display updates.

Further details on the sample project can be found in the index.html file available in the 78K0/Kx2-L —
Save [t/ CD-ROM “\doc\visualSTATE\samples” folder.

12.3 Running the sample project

To perform changes on the visualSTATE parts open the visualSTATE workspace file within the
“\samples\IAR visualSTATE sample project\vs” folder of the CD-ROM. After loading the
workspace the window should look like shown below.

‘ £ visualSTATE Navigator, [Demo] - [StartNoAnimation. htm]

& Fle Edit View Project Tools Window Help Jﬂ&
! DEE [l e Address | -ems\visualSTATE 6,1 Demo|DoclStartNoAnimation him _~ | A0
{ i
=

= B Ficact: 1 Project(s)
= & React : 1 System(s)
& Reaction
=23 Validator Workspaces
AP React vws
(1 Test Sequence Files
=3 Reports
B vscoder cre
T React him
B vscoder cre

MODELING
M React itf -

PROJECT
MANAGEMENT VALIDATION

CODE GENERATION

]
|

General /. Code Generafion _» Verification_», Documertation 5, _Custom Commands 1«

Figure 42: IAR visualSTATE navigator

If the functionality or the settings of the sample shall be changed open the visualSTATE Designer.
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Eile Edit ¥iew Insert Format Tools window Help

=H &l M BME W Qg e Th - e

* n.Reaction - (Statechart Diagram)
= React: 1 System(s]
=-8& Reaction [ ; AT TEweT TEqUITEmEntE Tor an APPTCaTIon ThaT MeSsures your 123
= [ Reaction ime
O InitState B In tState AnyButton ¢ escription:
Entry / InitS othware Timers(y he application can be started by praszsing one of the buttons.
O Test [eSumReactionTime=1] hen the application randomly selects S5 or SVIS for you to press. It
{0 DisplapResult [iNTests = 0] Displaylnit. ells you which ane to press by showing something at the display. After
O Measure ~ hat it shows you your reacdion time in milliseconds,
O <niials - bitter randomly selecting 2 button foryou to press 10 times, it displays the
werage reaction ime by switching bebween "4 and your reaction time
) WrangButton = Test teszing the wiong button before the conect one should be "prohibited”
Entr / [iButtani:hoice =GelectkandomBution(] ' some way
< AnyButton ¢ [iTimeBetmeenT ests = SelectTimeBebuen T esta)]
i i Test(aTi T ired,
TimeRetueenTests)
Q Entry / DisplayClean)
®
@ [Collection of possible events (Derived fam high-level I~
eTimeBetubenTestEspire ppecification)
® i leButtons: Indicates user has presced button SWS conscted to INTPD
WrangBution leButtont: Indicates user has pressed button SUIS conected to INTPZ
@ Entry [ [INIT asts = (N7 asts-1] eButtons() leTimeBebueenTestsExpired: The time from prewious button press until
Displayinitialhdessage: eButtons( [iMTlests<oNumberDT ests] nexd test
" . [iNIT ests< cNumberfT ests s . ! !
® [iButter(Cheice == 0] / [iButtenChaics == 1] ftopRAa Collection of pessible action functions:
StopReactignTimerAndRead)) isplaylnitialMessage: Showsomething on the displaywhen application
[ ] is stated
] <Buttons0 DisplayLeftRight: Display symbol on 'left or'right digit to indocate S
e C o 1o Ehean o1 WS buttan to press
i |Enty7 (NrTesE= iNmessr isplayResult: Show awerage result of reaction tests
DisplayLefiRightiB utten Ghaive) StartReastion Timei) [StartfieactionTimer: Starttimer for reaction measurement. This iz not a
timer action, since it is free running
Q eButtonfiy SelectRandomBution: Randomize which button user should press
(ButtonChoice =, TimerctionTimeBetmeenT ests: Start the timer that determines the
interval between tests. Thisis a pure imer action thatshould specify an
lewent to be posted when the timer expires
eTimerOverlon) £ topReactionT ad: Stop the timer and read out
bisplayClaam he count value
StopReactionTime rhndRe eButtonQ|[HIT ests == cHumberOfTests] eBittona0) [iNTests = SelectTimeB etweenTests: Returm a (possibly randomizedyalue for the
[iButtenChaice ’ cHumberOf[l este] [iButtonChejce == 0] [interval between tests
it ctionT 0 i StopRdactionT adg  [DisplayClear Tum off all segmens in the display
InitS oftware Timers:
AnyBution ¢ StopSoftware Timers: Functions to init and stop the sofiware timers and
SHapBnfimare Time =) [ DT | he commaspanding hardware timer.
f..u 7 Displayresult) J
v
¢ >
* [Loading file: C:AT emph78KOR_5 aveitvs \Feaction. var F
- Aeading local elements...
- Reading state information...
- Reading Transition5tate Reaction information,
- C:ATemph7BKOR_S aveit\wS\Reaction.vsr loaded.
Froject: C:ATemp\TaKOR_SaveitwS\React vsp laded
1 Swstemlz)
2Filefs] Mi
H Source Cortrol Ll
Ready (1226, 140) 75%

Figure 43: IAR visualSTATE designer

To run the project on the TK-78K0/KC2L board locate the IAR Embedded Workbench workspace file (78kK0-
SAVEIT sample project.eww) within the “"\visualSTATE\EW” folder of the installation of the sample
projects.
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/% IAR Embedded Workbench IDE CEX
File Edit View Project Tools ‘Window Help
DeEdd & & | =l wREB HWH S 2L
x - x
|DEhUD ﬂ ! 48 /% This is a good place to set @ breakpoint during debugging. 3 7
& | 49 woid HandleError (unsigmed char cc)
Files on | B o
B (J 78K0_SAVEIT_sample_project ... v 511
a1 Eventtueus o
| simpleEvantHandler.c o
1 SottwareTimer 54void main(void)
| L@ [vs_SoftwareTimers.c 55
& B initialise.c 56
l—I nterrupt.c 57  SEM_ACTION_EXPRESSION_TVPE actionExpressNo;
& @ mainc 58 /% Define end initialize. #/
[ Reactvsp 53 SEM EVENT TYPE eventlo;
[0 ¥S_aActionFunctions.c 60 unsigned char cc:
L@ (3 Output 51
62
a3
64 SEQ Initialize():
65 SEQ_AddEvent (SE_RESET); // Should preferably be done before enabling interrupts that can produce .
af
67 §if (READABLE==1)
68 ReactionVSInitdll(): A New API name for readakle code
60 gelse
70  ReactionSEM Initdll(): ./ Remember to enable this function in coder options "API Fumctions™
71 gendif
72
3 73 _ enable_interrupti): S enable 21l interrupts g
7aK0_SAVEIT_sample_project H‘”| ‘ pl | | »
x
Messages File
Building configuration: 78K0_SAVEIT_sample_project- Delbug
Updating build tree...
Configuration is up-to-date
< ¥
Euild [ Debug Log | Find in Files | Breakpaints E
Ready Errors 0, Warnings 0 Ln &4, Col 20 UM =
e

Figure 44: IAR Embedded Workbench visualSTATE sample project

When loading the visualSTATE sample project all necessary settings to run the application on the TK-
78K0/KC2L are already set. So the user just has to download the application to the target device.

The application can be downloaded by click Project > Debug.

Note:

When facing the following error messages during the build process of the IAR project please

use the Rebuild all function within the IAR Embedded Workbench (Project = Rebuild all).

Error[e46]: Undefined external "ReactionSEM_InitAll" referred in main ( “Project Dir”\ Debug\Obj\main.r26 )
Error[e46]: Undefined external "ReactionVSAction" referred in main (“Project Dir’\Debug\Obj\main.r26 )
Error[e46]: Undefined external "ReactionSEM_GetOutput” referred in main (“Project Dir"\Debug\Obj\main.r26 )
Error[e46]: Undefined external "ReactionSEM_NextState" referred in main (“Project Dir’\Debug\Obj\main.r26 )
Error[e46]: Undefined external "ReactionSEM_Deduct" referred in main (“Project Dir’\Debug\Obj\main.r26 )

For further information regarding this issue please refer to the IAR visualSTATE Release
Notes (readme.en.html) available in the root directory of the IAR visualSTATE installation

12.4 Debug the 78K0/Kx2-L — Save It! visualSTATE sample project

After downloading the application to the target device all from the C-SPY debugger already known debug
features are available. Furthermore more visualSTATE specific Debug features can be used like an actual
State view or a graphical animation of the states and state switches. For further information about the
visualSTATE C-SPY plug-in please refer to the regarding chapter in the C-SPYLinkUserGuide.pdf which
is located in the “\doc\visualSTATE” folder.
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13. Cables

13.1 USB interface cable (Mini-B type)

S —

Series "A” Plug Series "Mini-B” Plug

Series "A" Plug  Series "Mini-B” Plug
&

i

<

~Eik= [7] B

Figure 45: USB interface cable (Mini-B type)

User's Manual U20194EE1VOUMOO

49



78K0/Kx2-L — Save It! NEC

14. Schematics
Please find the schematics attached to this document. To open the attachments view in the Adobe Reader

press the paper clip in the lower left corner of the window. To open the attachment double click the
TK-78KOKC2L_schematic.pdf
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